
  

TS
80

00
 

 

Link RTN Option 
8000/LK/00 

HA470411U001 Issue 2 

  

Parker 



  

© Copyright Parker Hannifin Corporation 2009 

All rights strictly reserved.  No part of this document may be stored in a retrieval 
system, or transmitted in any form or by any means to persons not employed by 
Parker Hannifin without written permission from Parker Hannifin. 

Although every effort has been taken to ensure the accuracy of this document it 
may be necessary, without notice, to make amendments or correct omissions.  
Parker - SSD Drives cannot accept responsibility for damage, injury, or expenses 
resulting there from.   

Companies, names and data used as examples herein are fictitious unless 
otherwise stated. All trademarks and copyrights are acknowledged as the 
property of their respective owners. 

  



Table Of Contents TS8000 Option Card 

Table of Contents 
Product Overview ......................................................................................... 3 

General Description .................................................................................... 3 
Safety Information ....................................................................................... 4 
Contents Of Package ................................................................................. 4 

Specifications ............................................................................................... 5 
Power Requirements ................................................................................... 5 
Serial Communications ............................................................................... 5 
Fiber Optic Communications ...................................................................... 5 

Installation Instructions .................................................................................. 7 
Hardware Diagnostics ................................................................................... 9 

Module LED Status ....................................................................................... 9 
Network LED Status ...................................................................................... 9 
Diagnostic Codes ..................................................................................... 10 

Software Configuration ................................................................................ 11 
Configuring The Link System ...................................................................... 11 
Configuring The TS8000 HMI ...................................................................... 13 

 

 

Version 1.00.00 Page i 





Product Overview TS8000 Option Card  

Page 3 http://www.SSDdrives.com 

Product Overview 

I. 

 

• Configured with DSD software. 

• Noise-free fiber optic interface to any 
other devices on the high speed Link 
network. RS-232 serial comms interface 
to the TS8000 HM

• 24vDC powered by an external supply. 

• DIN rail mountable for ease of use. 

• Installation and connection hardware 
included with card. 

 

 

 

 

 

 

General Description 

The 8000/LK/00 option card provides a high speed interface (2.7Mbit) between 
the TS8000 series HMI and a Link fiber optic network.  This module is similar to a 
6055/LINK TechBox, but can be mounted on standard DIN rail instead of being 
plugged into a drive. 

The option card has two fiber optic terminals that accept 1000 micron acrylic 
fiber.  The transmit strength over the Link network can be adjusted via a 3-position 
toggle switch.  In addition, the option card also provides a standard RJ-style serial 
jack for connection to a TS8000 HMI. 

The 8000/LK/00 requires the use of an external 24vDC power supply connected to 
terminal block TB1. 
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Safety Information 

All safety related regulations, local codes and instructions that appear in the 
manual or on equipment must be observed to ensure personal safety and to 
prevent damage to either the instrument or equipment connected to it.  If 
equipment is used in a manner not specified by the manufacturer, the protection 
provided by the equipment may be impaired. 

Do not use the controller to directly command motors, valves, or other process 
actuators not equipped with safeguards.  To do so can be potentially harmful to 
persons or equipment in the event of a fault to the controller. 

 

Contents Of Package 

The option card will come shipped with the following additional equipment: 

• 8000/LK/00 option card. 

• Hardware mounting packet. 
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Specifications 
The following specifications pertain to the TS8000 series option cards. Parker SSD 
Drives retains the right to modify specifications at any time, without prior notice.  

Power Requirements 

Power is supplied to the option card from an external 24vDC supply connected to 
terminal block TB1 (200mA rated inrush, 65mA steady state). 

Serial Communications 

Cable Type: Parker SSD part number CM471054 (Standard TS8000 Comms). 

Fiber Optic Communications 

Fiber Type: Parker SSD part number CM056316U030. 

• Core Diameter: 1000 micron. 

• Cable Type: Acrylic. 

• Bending Radius: > 1 inch (25.4 mm). 

• Insulation: Vinyl > 1kV. 

Transmit Strength Settings: Switch SW1. 

• Center Position: Low intensity – 0-20 m transmit range (0-66 ft). 

• Up Position: Medium intensity – 21-40 m transmit range (67-132 ft). 

• Down Position: High intensity – 41-60 m transmit range (133-196 ft). 

 

Page 5 http://www.SSDdrives.com 





Installation Instructions TS8000 Option Card  

Installation Instructions 
The following specifications pertain to the TS8000 series option cards. Parker SSD 
Drives retains the right to modify specifications at any time, without prior notice.  

To install the option card, remove all power and I/O communication cables from 
the unit.   

Snap the 8000/LK/00 onto a standard DIN rail. 

Connect the RS-232 cable from the option card to the RS-232 Comms port of the 
TS8000. 

Connect the Receive Fiber into the black connector and the Transmit Fiber into 
the blue connector.  The fiber optic loop should be closed with the Link network 
as shown below: 

 

Connect external 24v DC power to both the TS8000 and the 8000/LK/00. 
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Hardware Diagnostics 

 

Module LED Status 

The Module LED (left side) indicates the configuration state of the 8000/LK/00. 

LED State Fault Description 

Off No Power * External 24v DC power not applied 

Slow Flash Initialization Fault * Self test failure 

(2 flash/sec)  * Module does not have a valid config 

Fast Flash Off Link Network * Module was halted by Link 

(4 flash/sec)  * Module is attempting to go online 

  * Config problem (L-Error, H-Error, or 

     duplicate address) 

On None * Module config is running and 

     communicating over the Link network 

 

Network LED Status 

The Network LED (right side) indicates the status of the connected Link network. 

LED State Fault Description 

Off Faulted * Network failure 

  * Module halted or initializing 

On None * Network healthy 

  * Module peer halted or duplicate 
dd   

Note: The Network LED can only be in the On state when the Module LED is On 
continuously, indicating that the 8000/LK/00 is ready for external communications. 
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Diagnostic Codes 

The Module LED (left side) indicates the configuration state of the 8000/LK/00. 

NCP State Module State Module LED Network LED 

0 Initializing Slow Flash Off 

1 Config Fast Flash Off 

2 Fault Slow Flash See note 

3 Fault Fast Flash See note 

4 Fault Fast Flash See note 

5 Fault Slow Flash See note 

6 Stopping --- --- 

7 Running On On 

8 Running On On 

9 Running On Off 

A Starting Fast Flash See note 

B Starting Fast Flash On 

C Fault Fast Flash On 

 

Note: LED state depends on whether the network is active at this node’s receiver.. 
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Software Configuration 
This document describes the necessary steps to configure the TS8000 HMI to 
communicate RS-232 to a Link network using Parker SSD Drives RTNx protocol.  This 
document is intended for those users who have a working knowledge of both the 
DSD and DSI8000 software packages. 

To implement this system, the TS8000 requires a device to act as its gateway to 
the Link network.  That gateway can either be a 6053/LINK or 6055/LINK TechBox, 
or it can be a L5300 Link Rack.  This application will use a TS8008 connected 
serially to a 6055/LINK TechBox as its gateway (Node 400).  The Link network will 
consist of: the aforementioned 6055/LINK, an L5300 Link Rack (Node 500), and a 
690+ AC Drive with a 6055/LINK TechBox (Node 10).  This topology is diagrammed 

as follows: 

For more information on the 605x/LINK TechBox refer to: HA470016 – LINK TechBox 
Instruction Manual, and for the L5300 refer to: HA353952 – LINK Rack Installation 
Manual. 

Configuring The Link System 

Programming the Link system requires the use of DSD version 1.21 or later and 
the Link Database Class Revision must be at 1238 or greater.  Earlier DSD 
versions do not have the required files to support communications with the 
TS8000 HMI.  To program the application, begin a new project with the 
following Link Templates: 

• TS8000TB – this will be the TS8000 gateway (Node 400). 

• L5300 – this will be a standard Link2 Rack (Node 500). 

• L690Pv5 – this will be a 690+ AC Drive with a Link TechBox (Node 10). 
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Configuring The TS8000 HMI 
1. Configure the Communications. 

 
• Navigate to the Communications section of DSI8000. 

• Select the RS-232 Comms Port by selecting it from the tree on the left. 

• Select the SSD Drives 890-RTNx driver from the applet at the right. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Use the Add Additional Device button to create two more devices for 
the Link rack and the 690. 

• Name each device as appropriate, and set each Destination Node 
field as defined above in the Link configuration. 
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2. Addressing Link data. 
 

At this point it is important to discuss how data is transferred in a Link network.  
All Link data is handled in a “Write-Forward” approach.  This means that data 
must be sent from the source node to the destination node.  Link nodes are 
not capable of requesting data to read.  The TS8000 HMI does not specifically 
follow this approach.  The TS8000 is capable of reading data as well as writing 
it.  In addition, from the TS8000’s perspective, inbound slot numbers must be 
less than 1024.  Because of this combined architecture, data exchange with 
the TS8000 will be handled as follows: 
 
How The TS8000 Writes Data To Link – Data going from the TS8000 may be 
written to ANY device on the Link network.  The individual TS8000 data tag 
uses the destination device mapping to specify exactly which node is being 
written to. 
 
 
 
 
 
 
 
 
 
 
 

Fiber
FiberRS-232

Serial
Fiber
Fiber

 
How The TS8000 Reads Data From Link – Data going to the TS8000 may only be 
written to the HOST device on the Link network.  The TS8000 data tag uses the 
source device mapping of the Host to specify exactly where the data is 
coming from. 
 

Fiber
FiberRS-232

Serial
Fiber
Fiber
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TS8000 Write Only Tags – Data from the TS8000 may be written to ANY device 
on the Link network.  In our sample application, this means that the TS8000 
may directly write data to the Host TechBox (Node 400), the L5300 (Node 
500), and the 690 Drive (Node 10).  This write data will be available at the 
destination node through a pre-defined Input Slot with the appropriate Slot 
Number.  The example below shows both the TS8000 data tag and the Link 
Input Slot to send a value to the L5300 (Node 500) at slot 1: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Write Only tag uses the L5300 (Node 500) device mapping, since that is 
the destination device for the data.  It specifies Write Slot 1, since that will be 
the incoming data slot that we will program at the L5300. 
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The L5300 is programmed with the Incoming Slot to receive the data from the 
TS8000.  This data is passed from the TS8000 via the Host TechBox (Node 400) to 
the L5300 (Node 500).  This data is now available to use as needed in the Link 
application. 
 
TS8000 Read Only Tags – Data from the TS8000 may be read ONLY from the Host 
TechBox (the node you are serially plugged into).  Because of this, all read data 
must be previously WRITTEN to the Host TechBox from the source node.  This read 
data will be available from the same pre-defined Output Slot number that was 
used to send it to the Host TechBox.  In our sample application, this means that 
the TS8000 may directly read data from the Host TechBox (Node 400).  The 
example below shows both the Link Output Slot and the TS8000 data tag to send 
a value from the L5300 (Node 500) to slot 2 of the Host TechBox (Node 400): 
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The L5300 is programmed with the Outgoing Slot to send data to the TS8000.  This 
data is sent to the Host TechBox (Node 400) and then read serially by the TS8000.  
You do not have to explicitly define an Input Slot in the Host TechBox for this data. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Read Only tag uses the Host (Node 400) device mapping, since that is the 
source device for the data.  It specifies Read Slot 2, since that is the outgoing 
data slot that was programmed at the L5300. 
 
TS8000 Read / Write Tags – TS8000 data is written to the destination L5300 
(Node 500), and read from the Host TechBox (Node 400).  At the Link level, the 
data exchange follows both of the methods described above, and therefore 
requires an Input Slot mapping and an Output Slot mapping.  The example 
below shows both the Link Input and Output Slots and the TS8000 data tag to 
read and write a value with the L5300 (Node 500): 
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The L5300 is programmed with the Incoming and Outgoing Slots to send and 
receive data to and from the TS8000. 
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 those are the data slots that were programmed at the L5300.  
Keep in mind that in this scenario, reads are ALWAYS implied to be from the 

3. 
  

ust be Read/Write Flags to work 
properly.  When using a TS8000 Flag to represent Logic Link data, no 

 is represented with the Integer data type.  When 
using a TS8000 Integer to represent Ordinal Link data, no additional scaling 

TS8000 Integer, ValueAsInteger, is used to represent a Link Value of 
-100.00 to 100.00.  To properly scale this number, several configurations must 

• From the Data Tab, in the Scaling and Transforms section, Linear 

he Store As 
fields (which represent the raw data coming from Link) were set to a 

 the Display 
As fields (which represent the scaled data in the TS8000) were set to a 

The Read Write tag uses the L5300 (Node 500) device mapping, since that is 
the destination device for the data.  It specifies both Write Slot 1 and Read 
Slot 2, since

Host node. 
 

Data Scaling and Type. 

Link data may be presented in one of three styles: 
 
Logic Data – is data that represents a two-state value (0 or 1, True or False, On 
or Off).  Logic data is represented as a full 16-bit word even though the state 
only uses the first bit of the word.  In the TS8000, Logic data is represented with 
the Flag data type.  Flags in the TS8000 must read the status of the entire data 
word before they can execute a write to a single bit.  This is because the 
TS8000 must preserve the state of the remaining 15 bits of the word.  This 
means that Write Flags in the TS8000 m

additional scaling transforms are required. 

Ordinal Data – is 16-bit unsigned word data that ranges between 0-65535.  In 
the TS8000, Ordinal data

transforms are required. 

Value Data – these are normalized numbers that are represented as 
percentage of 32767.  This means that value data with a range of -100.00 to 
100.00 translates to a range of -32767 to 32767.  In the TS8000, Value data may 
be represented with either the Real data type, or the Integer data type.  
When using a TS8000 Real to represent Value Link data, no additional scaling 
transforms are required.  However, if a TS8000 Integer is used to represent a 
Value Link data, additional scaling transforms will be required.  In the example 
below, the 

be made: 

Scaling was selected as the Transform type. 

• From the Data Tab, in the Scaling and Transforms section, t

minimum value of -32767 and a maximum value of 32767. 

• From the Data Tab, in the Scaling and Transforms section,

minimum value of -10000 and a maximum value of 10000. 
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• From the Format Tab, in the Data Limits section, the Minimum Value 
was set to -10000 and the Maximum Value was set to 10000. 

• From the Format Tab, in the Data Format section, the Digits Before DP
field was set to 3 and the Digits After DP field was set to 2.  This action is
responsible for formatting the scaled data to 2 decimal places. 
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Limited Warranty 
 

Parker SSD Drives warrants the goods against defects in design, materials, 
and workmanship for the period of 12 months from the date of delivery on 

the terms detailed in our Standard Conditions of Sale. 

Parker SSD Drives reserves the right to change the content and product 
specification without notice. 
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